LEARNING OUTCOMES

T8-1

Plug-In T8

Decision Making Using
Access 2013

Describe the steps for creating a form using the Form Wizard in Access.
Describe the steps for creating and saving Forms using Access.

Describe the steps to modify the properties of a form using Access.
Describe the steps for creating a report using the Report Wizard in Access.
Describe the steps to modify the properties of a report using Access.
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Introduction

This plug-in focuses on the two functions of decision making using Access
2013: creating forms and creating reports. A form is nothing more than a
graphical repre-sentation of a table. You can add, update, and delete records in
your table by using a form. Although a form can be named differently from its
corresponding table, they both still manipulate the same information and the
same data. Hence, if you change a record in a form, it will be changed in the table
as well.

A form is useful when you have numerous fields in a table. It allows you to see all
the fields in one screen, whereas if you were in the table view (datasheet) you would
have to keep scrolling to get to the field you desire.

A reportis an effective way to present your data in a printed format. Because you
have control over the size and appearance of everything on a report, you can dis-
play the information the way you want to see it.

Forms

An Access form is a window, similar to a dialog box, that contains a set of controls
(such as labels, text boxes, and check boxes) to view, enter, or edit database infor-
mation, typically one record at a time.

In a form, data are obtained directly from one or more tables or from data that
have been extracted using a query. Although it is possible to directly enter and edit
the information in tables in Datasheet View, a database usually includes a set of
forms that can make entering and editing data considerably easier and can limit
the fields that can be viewed or modified.



CREATING A FORM USING THE FORM WIZARD

Forms allow you to enter data one record at a time. Often, it is easier to enter data
in a well-designed form rather than in a wide datasheet. You can create a form that
has fields from more than one table or query. Like other wizards, the Form Wizard
walks you step-by-step through the process of creating a form.

To create a form using the Form Wizard:

1. Open the file T8_SlopesideBikes_Data.mdb from the data file that accompanies
this text.

2. Click the Create tab. Click Form Wizard.
3. Click the Tables/Queries drop-down arrow and select Table: BIKE.

4. Add all BIKE fields by clicking on the double right arrow ( >>). Click Next to go to
the next step.

5. Select the Columnar form layout. Click Next.
6. Type in BIKE FORM for a form title.
1. Click Finish to open the form and begin entering data (see Figure T8.1).

Accessing Several Tables or Queries in a Form

When you select the fields for your form in the first Form Wizard dialog box, you
can add fields from several tables or queries. To add fields from each table or query,
select it in the Tables/Queries drop-down list and then use the buttons to move the
fields you want to the Selected Fields list.

If you add fields from several forms or queries, the wizard will display one or two
additional dialog boxes that were not shown in the previous section: one dialog box
in which you specify the form or query by which you want to view your data (for
example, if you selected fields from the CUSTOMER and the BIKE tables, you would
choose to view your data either “by Customer” or “by Bike”) and possibly another
dialog box in which you select a layout for a subform. The choices you make deter-

mine the form’s record source.
FIGURE

Create a Form by Using
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If your form includes fields from two tables that are related in a one-to-many
relationship and if you selected to view your data by the primary table, the wizard
will let you display the records from the related table in a subform contained within
the form. As an alternative, the wizard will let you set up a linked form, which is a
separate form that displays the related data and which you open by clicking a but-
ton on the main form.

On the other hand, if you chose to view your data by the related table in the one-
to-many relationship, when the form displays a record in the related table, it will
simply display the unique matching fields from the primary table along with the
fields from the current record in the related table.

A form that accesses data from several tables or queries can be complex to design
from scratch or to modify. However, if you create the form using the Form Wizard,
almost everything is set up for you.

CREATING AND SAVING FORMS

To create a simple form in Access, you can use the form buttons available on the
Create tab. You can create a basic form, split form, tabular form using multiple
items, blank form, or PivotChart.

To create a form:
1. In the Navigation Pane, select the CUSTOMER table.
2. Click on the Create tab, and then click on the Form button (refer to Figure T8.2).

3. Access automatically creates a Columnar Form based on the CUSTOMER
table you selected. Since the CUSTOMER table has a linked relationship to the
RENTAL table, Access displays the RENTAL table contents associated with the
CUSTOMER information.

4. Close the form by clicking the Close box in the upper-right corner.

FIGURE 5. Access will automatically prompt you to save the form. Save it as CUSTOMER.
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FIGURE

Modify Form Properties
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MODIFYING THE PROPERTIES OF A FORM

Once you have created a form, you can still change the way the form looks
and functions. The Format, Arrange, and Design tabs allows you to change the
form’s graphic style. Opening the Property Sheet dialog box allows you to change
other form properties.

MODIFYING SPECIFIC CONTROLS ON A FORM

Not all controls on your form may be of equal importance. You may want to modify
the look of a specific control to make it stand out, or you may want to modify the
control behavior. When designing forms, be careful not to overdesign. Too many
different colors, styles, or behaviors can distract from accurate data entry.

To modify the properties of a specific control (refer to Figure T8.3):

1. Open the BIKE FORM in Design View.

2. Since the BIKE FORM you created using the wizard did not allow you to align the
title of the form, you should do that.

3. Click the Property Sheet button on the Design tab.

4. Under the Form Header, select the BIKE FORM title object. Notice that there are
handles around the object creating a box that is reddish in color.

Select
control
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Drag the right-middle handle so that it is as wide as the rest of the form.
In the Property Sheet dialog box, click the Format tab.

Click the Font Weight property, and select Bold in the drop-down list.
Click the Text Align property, and select Center in the drop-down list.
Close the Property Sheet dialog box.

10. To view your changes, click on the View button and select Form View.

© 0N & o

11. Close and save the form.

Note: Common properties to modify are the use of scroll bars and growing or
shrinking the size of the control based on data the user enters. If you turn off scroll
bars, users can see only the data that fits within the specific control dimensions. If
you turn on Can Grow or Can Shrink, the control area will grow and/or shrink to fit
the data.

Many formatting options are available from the shortcut menu (selecting a con-
trol, then right-click). You can change the background color, font color, and which
special effect is applied to the control.

Reports

Reports are used primarily for printing selected database information. A report
labels, groups, sorts, and summarizes the data it presents. Like a form, a report
can display data directly from one or more tables or it can display the results of a

query.

Using the Report Wizard

Like other wizards, the Report Wizard walks you step-by-step through the process
of creating a report. Unlike forms, which are designed for on-screen data entry,
reports are designed for print.

To create a report using the Report Wizard:

1. Click the Create tab, and then click the Report Wizard button in the Reports
group.

2. Click the Tables/Queries drop-down arrow. Select the CUSTOMER table and
select all the fields except the Drivers License, Telephone, and Credit Card No.
Then select the RENTAL table and select the Date field. Lastly, select the BIKE
table and select the Description field.

3. Click Next to go to the next step. Note: If you selected fields from more than one
table or query in the previous step, the second Report Wizard dialog box asks
you to choose one table or query that will be used for grouping the information
in the report, if possible.

4. The next step asks how you want to view the report. Double-click BIKE. Click
Next.

5. Make Date the first grouping level. (Note: Use a grouping level to organize the
data into subgroups by the value of a specific field.) Click Next.

. Next, for sort order, specify State as the primary data sort. Click Next.
. Select the Stepped report layout and Landscape orientation. Click Next.
. Select the Office style for the report. Click Next.

. Type in Customer Rental by State Report for the title and select Preview the
report.

10. Click Finish. Figure T8.6 displays the results.

O 00 ~N O
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Customer Rental by State Report

Spegialized
May 2004

PA Smith Sue 214 Ozk Avenue Philadelphia 19019

Specialized
June 2004
PA Smith Sue 214 Oak Avenue Philzdelphiz 19019
July 2004
NY Dunn David 3 vy Lane New York 10151
Trek Fuel 7
June 2004
MHN Myers Mike 567 5th Street Minneapols
MHN Myers Mike 567 5th Street Minnezpcls
Trek Fuel 8
Some data Too much space. Cannot see date column.
are cut off.
FIGURE MODIFYING THE REPORT DESIGN

View Report Once you create a report, you can modify the report’s design to make it more visu-

ally attractive. As with forms, be careful not to overdesign your report. A poorly
designed report can distract from the information being presented. To modify the
design, you must have the report open in Design View.

To modify the report design:

1. Preview the report first. Double-click the Customer Rental by State Report in
the Navigation Pane. Notice that the columns and data do not align correctly,
some columns are much bigger than they need to be, and we can’t even see the
date field (refer to Figure T8.6).

2. Switch to Design View by clicking the View button (under the Home tab).

3. Click the Description control under the Bike_Id Header section, and then drag the
sizing right handle to increase the width of the control box (this will allow more
characters to be visible in the report). You can also select Size from the Format
menu. Select To Fit to automatically resize the label or control to fit your data.

4. Make sure that you can see the Date column control. You may have to adjust the
width of that control. Select the State column heading and resize that control to
have fewer spaces.

5. Switch to Report View via the View toolbar button to see your changes. You may
have to toggle back and forth from the Design View to the Report View several
times before you get the results you desire. Figure T8.7 displays the modified
report.

Note: Change the graphic style of the report by clicking the Arrange tab, then
clicking the AutoFormat button.

Plug-In T8 Decision Making Using Access 2013



Customer Rental by State Report

Specialized Rockhopper
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CHANGING MARGINS AND PAGE ORIENTATION FOR REPORTS

The default page orientation for a report is portrait. This means the height of the

5/30/2004

Data are aligned,
> viewable, and
printable.

7/11/2004

7/12/2004

FIGURE
Modified Report Properties

page is greater than the width. You may want to change this orientation to land-
scape to accommodate multiple columns of data so they fit on one page. Margins
are the blank spaces at the top, bottom, left, and right of a report. By adjusting the
page margins, you can control the number of records printed on each page. Use the
dialog box to adjust margins and page orientation for your reports.

To change the margins for a report:

1. Open the report in Design View.

2. Click the Page Setup tab, and then click the Page Setup button in the Page

Layout group.

3. Select the Print Options tab in the Page Setup dialog box.

4. Change the values for the top, bottom, left, or right margin.

5. Click OK.

To change the page orientation for a report:

1. Open the report in Design View.

2. Click the Page Setup tab, and then click the Page Setup button.

3. Select the Page tab in the Page Setup dialog box. Click the radio button for

Portrait or Landscape orientation.
4. Click OK.
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* PLUG-IN SUMMARY

the Form Wizard option. The Form Wizard lets you choose the specific fields to include,

T o have Microsoft Access 2013 create a form according to your specifications, select

and these can belong to one or more tables or queries. To have Access quickly cre-

ate a form that has a particular configuration (Columnar, Tabular, Datasheet, PivotTable, or
PivotChart), based on the record source table or query you select in the drop-down list, select
one of the five AutoForm options. Access will immediately create the form, including all fields
from the record source and using default options without asking for your specifications.

To have Access help you design a report, select the Report Wizard option. To use default
settings to quickly create a report based on a single table or query, with a columnar or tabular
layout, select the AutoReport: Columnar or the AutoReport: Tabular option. Either report will
include all the fields belonging to the record source table or query that you select in the drop-
down list at the bottom of the New Report dialog box.

* MAKING BUSINESS DECISIONS

1. WasteNot Recycling
WasteNot Recycling, introduced in Plug-In T6 and reintroduced in T7, picks up recyclables
from homeowners in Boulder, Colorado. The owners of WasteNot Recycling have asked
you to assist with creating a form and several reports. They have provided you with an
updated database file, T8_WasteNotRecycling_Data.mdb. Specifically they want you to do
the following:

1.

Create a form that will allow the owners to enter data into the CUSTOMER and the
CUSTOMER RECORD tables. They have left the design (i.e., aesthetics) up to you.
However, they have asked that you locate an appropriate graphic to include on the form.
You will want to use the Internet to find such a graphic. Make sure you align all the con-
trols and adjust the size of all the controls to fit the data. Save the form as Customers.
Create a report that groups the records by customer. The report should include data on
the customer first and last name, service date of pickup, weight of paper, and weight of
other. The report should be sorted by customer last name. You will need to create a sub-
total for the weights for each customer. Create a report title called Customer Weights.

2. It’s A Grind Coffee Shop
It's A Grind Coffee Shop, introduced in Plug-In T6, is an Oakland, California, neighborhood
coffee shop. Kate Fitzgerald, the proprietor, has decided that she needs a form and a few
reports created to help her purchase new books for her coffee shop.

1.

Kate has provided you with an updated database file, T8_IltsAGrindCoffee_Data.mdb.
Specifically, Kate wants you to:

Create a form that will allow Kate to add new books to the BOOK table. Kate has asked
you to use a Columnar layout and the Sumi Painting style. Kate has given you her logo
to add to the form, ltsAGrindlmage.jpg. Position the logo in the top-left corner. Save the
form as Books.

Create a report that groups the records by author. Include only the author from the
AUTHOR table, and book title, year, and condition from the BOOK table. Sort the report
by book title. Create a title labeled Current Authors; center the title on the report. Set
the label properties to 12 point, bold, italic. Save the report as Books By Author.

T8-8
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3. Create a report using the publisher name, book title, year, and author name. Group the
report on publisher name and sort on the year the book was published. Create a report
title of Books By Publisher. Align the columns evenly and use a professional-looking
font style and layout. Save the report as Publishers.

3. TechIT Seminars
TechlT Seminars is an organization of independent seminar facilitators who provide onsite
technical training to large businesses around the world. The facilitators build curriculum that
is marketed by TechlIT. TechIT books the seminars, arranges facilities, enrolls participants,
and collects the money. While the facilitators are not employees of TechlT, they provide the
service that is marketed, and their skills and schedules need to be available to all TechlIT of-
fices. Deborah Wallbridge has been charged with tracking facilitators and their classification.
She has asked you to help develop a form and a few reports to assist in scheduling seminars.

1. Use the T8_TechITSeminars_Data.mdb file.

2. Create a data entry form for the FACILITATOR table. Set the form background color to
a blue color (hue). Organize and align all controls for effective use and full data display.
For the phone data, use the Phone input mask. Save the form as Facilitators Form.

3. Use the ENROLLMENT table to create a report listing the students currently enrolled
in each seminar. The report field order is Seminar ID, Last Name, First Name, Student
Phone, and Student Number. Adjust all controls to display all of their contents. Adjust
the color and content of the column headings as shown in Figure T8.8. Align all controls.

FIGURE
Students by Seminar
Students By Seminar Repo revort
y 3 Report
SeminarID  Last Name First Name Student Phone Student Number
TLOO3
Elynuik Kerry 539-556-3223 115
Ray Iaria 217-226-4415 135
Ross Wilbert 395-444-2247 244
Timmerman Henry 123-225-8543 229
Tsuhara Gordon T7-1-655-4487 124
Weinstein Albert 120-22-547-5684 108
TLO10
Malone Sean 894-544-6637 31
Margaard Max 315-554-7T787 33
Rodrigues arc 938-224-1135 249
Tarchuk Sapphire 217-544-2014 131
Van Zandt Willem 439-455-3112 77
TR101
Dhaliwal Frank 452-332-4125 250
Hahib Akram 315-335-4414 186
Harrison Tina T43-441-3352 109
Kowalski Byron 976-255-3177 2
Mahal Balinder 543-337-8541 308
Mckahon Lavon 315-225-6634 330
MNadeau Pierre 675-441-6511 325
Cakes Judy 603-221-4473 255
Pittmian Dale 43-848-332-6674 455
Pryor Deanna 48-438-378-6767 166
Quinn Dwayne 315-224-3581 283
Reyes Herbert T2-334-6142 208
Weymouth Corey 303-335-4712 181
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Add a gray line above and below the column headings. Use Sorting and Grouping to
sort by Seminar ID, Last Name, and First Name. Place the report date, time, and Page
XX of XX'in the Page Footer. Format the date and time to long format. Save the report as
Students By Seminar Report.

4. Scale Classic Cars
Johnny Krol, introduced in Plug-In T7, runs a body shop that specializes in restoring classic
cars. Johnny owns three classics and began collecting scale models when his wife put her
foot down and said no to building more garage space for his cars. Johnny has decided that
he needs a form and a few reports created to help in identifying the buying habits of his cus-
tomers. Johnny has provided you with an updated database file, T8_ClassicCars_Data.mdb.
Specifically, Johnny wants you to:

1. Create a form that will allow Johnny to enter new classic cars and update existing
records. The form should use a Columnar format and the Sandstone style. Save the
form as Catalog.

2. Create a report listing classic cars grouped by their make. The report should display all
fields from the CATALOG table, sort by model name, and calculate the average price for
each make. Use the Formal style. Save the report as Cars By Model.
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